
 

 

 

 

 

UNIT-II 

TOPIC-1 

                                Introduction to MS Office 

Microsoft Office (or simply Office) is a family of server software, and services developed by 

Microsoft. It was first announced by Bill Gates on August 1, 1988, in Las Vegas. The firstversion of 

Office contained Microsoft Word, Microsoft Excel, and Microsoft PowerPoint. Over the years, Office 

applications have grown substantially closer with shared features such as a common spell checker, 

data integration etc. Office is produced in several versions targeted towards different end-users and 

computing environments. The original, and most widely used, is the desktop version, available for 

PCs running the Windows, Linux and Mac OS operating systems. Office Online is a version of the 



software that runs within a web browser, while Microsoft also maintains Office apps for Android and 

iOS.Microsoft Office is a suite of desktop productivity applications that is designed specifically to be 

used for office or business use. It is a proprietary product of Microsoft Corporation and was first 

released in 1990. Microsoft Office is available in 35 different languages and is supported by 

Windows, Mac and most Linux variants. It mainly consists of Word, Excel, PowerPoint, Access, 

OneNote, Outlook and Publisher applications. Microsoft Office was primarily created to automate 

the manual office work with a collection of purpose-built applications. Each of the applications in 

Microsoft Office serves as specific knowledge or office domain such as: 

1. Microsoft Word: Helps users in creating text documents. 

2. Microsoft Excel: Creates simple to complex data/numerical spreadsheets. 

3. Microsoft PowerPoint: Stand-alone application for creating professional multimedia 

presentations. 

4. Microsoft Access: Database management application. 

5. Microsoft Publisher: Introductory application for creating and publishing marketing materials. 

6. Microsoft OneNote: Alternate to a paper notebook, it enables an user to neatly organize their 

notes. Besides desktop applications, Microsoft Office is available to use online or from cloud under a 

lighter (Office Web Apps) and full (Office 365) version. As of 2016, Microsoft Office 2016 is the latest 

version, available in 4 different variants including Office Home Student 2016, Office Home Business 

2016 and Office Professional 2 and the online/cloud Office 365 Home Premium. 

                                              Important Features of Ms-Word 

Ms-Word not only supports word processing features but also DTP features. Some of the important 

features of Ms-Word are listed below: 

i) Using word you can create the document and edit them later, as and when required, 

by adding more text, modifying the existing text, deleting/moving some part of it. 

ii) Changing the size of the margins can reformat complete document or part of text. 

iii) Font size and type of fonts can also be changed. Page numbers and Header and Footer can be 

included. 

iv) Spelling can be checked and correction can be made automatically in the entird document. Word 

count and other statistics can be generated. 

v) Text can be formatted in columnar style as we see in the newspaper. Text boxes can be made. 

vi) Tables can be made and included in the text. 

vii) Word also allows the user to mix the graphical pictures with the text. Graphical pictures can 

either be created in word itself or can be imported from outside like fro Clip Art Gallery. 



viii) Word also has the facility of macros. Macros can be either attached to some function/special 

keys or to a tool bar or to a menu. 

ix) It also provides online help of any option. 

                                         Introduction to Ms-Power Point 

A PowerPoint presentation is a presentation created using Microsoft PowerPoint software. The 

presentation is a collection of individual slides that contain information on a topic.  PowerPoint 

presentations are commonly used in business meetings and for training and educational purposes. 

Microsoft PowerPoint is a software product used to perform computerbased presentations. There 

are various circumstances in which a presentation is made: teaching a class, introducing a product to 

sell, explaining an organizational structure, etc. The preparation and the actual delivery of each are 

quite different. PowerPoint typically comes with a set of preloaded themes for you to choose from. 

These can range from simple color changes to complete format layouts with accompanying font text. 

Themes can be applied through the whole presentation or a single slide. Using the page setup allows 

you to optimize the presentation for the display size; for instance, you should use a larger screen 

ratio when displaying on a projector compared to a computer screen. 

                                                     Features 

PowerPoint software features and formatting options include a wizard that walks you through the 

presentation creation process. Design templates---prepackaged background designs and font styles 

that will be applied to all slides in a presentation. When viewing a presentation, slide progression 

can be manual, using the computer mouse or keyboard to progress to the next slide, or slides can be 

set up to progress after a specified length of time. Slide introductions and transitions can be added 

to the slides. 

                                                     Introduction to Ms-Excel 

Microsoft Excel is a general-purpose electronic spreadsheet used to organize, calculate, and 

analyze data. The task you can complete with Excel ranges from preparing a simple family 

budget, preparing a purchase order, or managing a complex accounting ledger for a medium 

size business. 

                                                        Excel Features 

There are a number of features that are available in Excel to make your task easier. Some of 

the main features are: AutoFormat - lets you to choose many preset table formatting options. 

1. AutoSum - helps you to add the contents of a cluster of adjacent cells.  

2. List AutoFill - automatically extends cell formatting when a new item is added to the end of a list. 



3. AutoShapes toolbar- will allow you to draw a number of geometrical shapes, arrows, flowchart 

elements, stars and more. With these shapes you can draw your own graphs. 

4. Drag and Drop - feature will help you to reposition the data and text by simply dragging the data 

with the help of mouse. 

5. Charts - features will help you in presenting a graphical representation of your data in the form of 

Pie, Bar, Line charts and more. 

6. PivotTable - flips and sums data in seconds and allows you to perform data analysis and 

generating reports like periodic financial statements, statistical reports, etc. You can also analyse 

complex data relationships graphically. 

7. Shortcut Menus - commands that are appropriate to the task that you are doing appear by clicking 

the right mouse button. 
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                                                         Introduction to Microsoft Excel; 

Objectives 

• Recognize Excel’s basic operations and tools; • Develop simple worksheets; • Use formulas; • 

Format worksheets; • Understand how to use Excel’s functions; • Understand how to sort; What is 

Excel? 

Microsoft Excel is a general-purpose electronic spreadsheet2 used to organize, calculate, and 

analyze data.  The task you can complete with Excel ranges from preparing a simple family budget, 

preparing a purchase order, create an elaborate 3-D chart, or managing a complex accounting ledger 

for a medium size business. 

 

                              This workshop will teach you the basic functions of Excel. 

Objectives: 

1 Adapted from Byte Back’s- Introduction to Excel . 

2 A table of values arranged in rows and columns. Each value can have a predefined relationship to 

the other values. If you change one value, therefore, you may need to change other values as well. 

1. Open a workbook . 

2. Understand cell addresses. 

3. Use the Help Menu “what’s this” to understand parts of the spreadsheet.  

4. Understand the Formula Bar. 



5. Toolbars:  Standard and Formatting. 

 6. Activate a cell so you can edit it. 

7. Enter Labels/text in cells 8. Enter Data/Numbers in cells 9. Undo the last action 10. Save the 

current document. 11. Recognize different cursors 12. Use the AutoFill cursor—the black plus 13. 

Automatically add the cells in a range. Note the Letters above each column of the worksheet: A, B, 

C… Use the Scrollbar at the bottom of the worksheet to see the single letters turn to double letters: 

AA, AB, AC…Use the combination “Control + Home” on your keyboard to return to the beginning of 

the worksheet. You can also use the arrow keys on your keyboard to move on the worksheet.  Note 

the Numbers beside each row of the worksheet: 1, 2, 3…Use the Scrollbar at the right side of the 

worksheet to see the numbers go into the hundreds. Use the combination “Control + Home” on your 

keyboard to return to the beginning of the worksheet. 

SPREADSHEET BASICS: 

You can get help from Excel in learning the parts of the spreadsheet.  With the mouse pointer click 

on the Help menu, scroll down and click on “What’s This?”  The cursor will become a Question Mark 

and you can click on any part of the toolbar to learn more about it.  Using the Question Mark Cursor, 

find the Formula Bar and click on it.  Observe the difference between the cell contents and the 

Formula Bar contents. 
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NOTE:  “click” always means left click—unless you are left handed.  “Double click” means double left 

click.  If the right button is the one to be used, the instructions will say “right click.” 

TOOLBARS: 

Using the View Menu you can turn toolbars on and off.  Go to View Toolbars and click on Standard—

if the toolbar was on it will turn it off, if it was off it will turn it on—this is called a “toggle switch.”  

Turn the Standard Toolbar and the Formatting Toolbar off and on and observe what is on them 

they are very similar to the Toolbars in Word and elsewhere in the Microsoft Office Suite. You can 

also turn the Formula Bar and Status Bar off and on with toggle switches on the View Menu. 

                                       ASPIRA’s CTC – Introduction to Excel  

The open worksheet has the first names of four people and their birthdays.  You are going to 

substitute names and birth dates of at least four people from your family or four friends. Click on the 

cell with the name, Jane. NOTE:  One click will select the cell and allow you to change the 

information. A double click will give you the insertion cursor and you can edit the information 

instead of completely replacing it. Type the name to replace this entry.  Use the tab key, arrow key, 

or mouse pointer to go on to the next column and replace the birthdays. Replace the names and 

dates in the other rows as well. NOTE:  If you make a mistake, you can use the Undo button just as 

you did in Word.  Or you can use the down arrow next to the undo button to undo several steps at 

the same time. When you have finished entering data and labels, click on the cell B1 to change the 

Title to match your entries—Instead of “Birthdays of my Children” you may want it to say “Birthdays 



of my Family/Friends.” SAVE AS: Save your worksheet with your name-Birthdays  Use Save As 

because you see where you are saving. 

WATCH THAT CURSOR! 

When the mouse pointer is over a cell, you have the white plus.  Left click on the cell to select the 

cell. Then move slowly towards the bottom of the cell—the plus will change into a white arrow—at 

the right hand corner it will turn into a black plus. 

ASPIRA’s CTC – Introduction to Excel  

MOVEMENT CURSOR: 

When you see the white arrow you can move or copy data.  (Session Three) AutoFill CURSOR:When 

you see the black plus — click down and drag and the contents will be copied—and Excel will try to 

fill in want it thinks you want.   

Introduction to Excel:  Note to the teacher: You may want to go over these exercises in class and 

then have the students repeat them on their own in lab or at home. Note to the student: You need a 

floppy disk to save your work, do lab exercises, and do long term projects. For Lab/Homework: 

Project 1--Using the Toolbars Using the Formatting Toolbar: NOTE: Select the cells that you want to 

format first.  

• On the worksheet your name - Birthdays select the names of the people and format these names 

using the buttons for Bold, Italic, and the pull down menus for font face and font size.  

• Format the labels at the top of each column.  Use the alignment button to center labels.  

• Format the title of the Table.Using the Standard Toolbar: 

 • Place the cursor in the cell below the column of ages and click on the sum button to get the sum 

of that column.  

• Click on one of the names and then click on the AZ sort button to alphabetically sort by names. 

 • Click on one of the dates and then click on the AZ sort button to sort by birthdays.  

• Click on one of the ages and then click on the ZA sort button to sort oldest to youngest. Top 5 

Favorites—An Excel Table: You are going to make a Table/List of your favorite fruits, first names, 

songs, movies, TV shows, tapes, singers etc.  Open a new workbook. 

TASPIRA’s CTC – Introduction to Excel  

• In cell B2 Type a Label that tells what is in the column—singers, TV program, Movie etc.  

• In cell C2 type the word Rating.  In this column you will rate each of the items according to how 

much you like them. Format your column labels. AutoFill NUMBERS: In the first column, A, skip the 

first two cells (These calls have the Table Title and the Column Label for A)  

• Type the numbers 1 in cell A3, and 2 in cell A4.  



• Select both cells--click on one, hold down, and drag to include both, and release the button.  

• Move the mouse till you see the AutoFill cursor the black plus. 

 • When you see it, click and drag down to fill in the rest of the numbers 1-5. 

DATA: Enter the information in column B, and rate them in column C. (Number 1 means your 

favorite) 

SORT: Select one cell in the Rating column.  Use the AZ sort button to sort by your Rating. 

SAVE AS: Save the file as your name-Favorites and bring it to the second session. 


